PCB Design Tips for PSPICE

1. TRACES

A.In the Combo bar for the trace size pull down on the drop box and
select trace_25. This is for a trace width of 25 mils. This size will ensure
that there is enough copper trace for a proper electrical conduction. If a
trace must go between two pads select trace_72. Trace sizes smaller
than trace_72 (12 mils) are not recommended.

6mils —0 g mils ——O
12 mils ""—-—o 25 mils q

If you need to run a trace between two pads, such as an IC, use 12 mils
between the pads and 25 mils for the rest of the trace route.
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2. PADS or VIAS

A. In the Combo bar for pad size pull down on the drop box and select
the proper pad size. Examples are below of the right pad sizes to use.
These sizes will ensure that there is plenty of copper pad to solder the
component too. The first number, .070 stands for the diameter of the
pad, 70 mils. The second number, .030 is the diameter of the drill
size, 30 mils.

Note: There are only 4 bit sizes available for drilling -
30 mil 40 mil 60 mil 125 mil bits
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B. Some of the pads in the component footprints of Pspice are too small
to solder to, but these pads can be changed with the Edit Attributes

[] button in the Tool bar. Highlight the component, then click the Edit
Attributes button and look for the attribute name - Via Padstack. This
attribute can be changed to a size that is usable for soldering.
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3. Placement of PADS and TRACES
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A. Do not use round and square pads together on the same component,
such as transistor footprints. Instead, use 3 round pads together Do
not place the pads and traces too closely together. The QuickCam
Machine needs space to mill your design and ensure proper isolation of
the components. Allow at least 12 mils between pads and traces.
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Working Files Needed for MicroSim PCB & ISOPRO

MicroSim PCB Files:

COMPONENT (Red) is the TOP layer
SOLDER (Blue) is the BOTTOM layer
DRILL (Gray) is the layer for the drill sizes

These are the only files needed to make a working PCB in IsoPro. Each one has
to be individually saved and exported as a separate layer and then individually
imported, into IsoPro, as a separate layer. Read step 4 of the handout Milling a
Circuit Board, to learn how this is done. Combining them all into one DXF file
will not work.

IsoPro Files:

BLUE is the COMPONENT layer
GREEN is the DRILL layer

In IsoPro, once you have REGISTERED and MIRRORED all layers the next step
is to ISOLATE the COMPONENT layer. This step will create an outline around
the pads and traces of your design so that the pads and traces will be isolated
from the rest of the copper on the board. Please read pages 17-23 provided from
the QUICK CIRCUIT User's Manual. These pages will take you step-by-step
through this process.

Board Outline File

A board outline file in MicroSim is not needed. This file can be created in
the IsoPro program or the QuickCam program.



Submit your drawing consisting of 3 files for a doubled-sided PCB
(COMPONENT, SOLDER, and DRILL) or 2 files for a single-sided PCB
(COMPONENT and DRILL) to the Lab Technician in Room #309, on a floppy
disk or email them to the Lab Technician:

email address:

You should sumit your design 3 or more weeks before your project is due. The
later you submit your design the less time you will have to make revisions on the
printed circuit board. The time for milling PCB'’s is during working school hours: 8
am — 5 pm. The Lab Tech. does not mill circuit boards on weeknights or
weekends.



MILLING A CIRCUIT BOARD

Read the QUICK CIRCUIT User's Manual. Everything you need to know, to
properly cut a PCB and use this machine, is in the manual. If you don’t read it
you could very possibly DAMAGE the OUICK CIRCUIT machine and cost the
ECE dept. hundreds of dollars, or more, in repairs.

Steps to milling a board:

1.

Load your drawing into the MicroSim PCBoard program

Check the Pads, Traces, and Drill holes to see if they are the proper size —
refer to the PCB DESIGN TIPS sheet

Go to FILE then drop to EXPORT and click on DXF

A list of Board Layers will be displayed and highlighted in black. Go and click
on the CLEAR ALL button. Next move the cursor arrow to the layer
selection and click on the word COMPONENT. This will be the ONLY layer
highlighted in black. Next click on the OK button. It will ask you for a file
name and where you would like it to be saved. SUGESTION: Whatever
name you select at the end add the word COMP so you can remember that
this is the component file and not get it confused with the drill file or other
milling files.

Next go back to step 3 then repeat step 4. But this time highlight the DRILL
layer and save it. =~ NOTE: For a double sided PCB you will have 3 files; the
COMPONENT file, SOLDER file, and the DRILL file. For a single side PCB
you will have 2: the COMPONENT and the DRILL file.

Close the MicroSim program and then open up the IsoPro program.



7. Under FILE drop to IMPORT and select DXF FILES. Find the 2 files you
saved, COMP and DRILL, and open up the COMPONENT file. As it coverts
the file it will ask you for the DXF IMPORT SETTINGS, just click the OK
button.

8. Your drawing is now converted to the IsoPro program. There should be 2
layers; a BLUE layer with the pads and traces and a GREEN layer with the
drill holes.

9. Now go to PAGE 17 of the QUICK CIRCUIT manual. Starting with the
paragraph about the layer list these pages will give you step-by-step
instructions on how to MIRROR the layer, REGISTER the layer, ISOLATE the
layer, and finally EXPORT the layer as a QUICKCAM file. The QUICKCAM
files are the final files the machine reads in order to mill a circuit board.

PLEASE READ THE QUICK CIRCUIT MANUAL AND FOLLOW IT STEP
BY STEP AND YOU WILL BE ABLE TO MILL A CIRCUIT BOARD
PROPERLY



ISOPRO TUTORIAL
IsoPro imports each file into a separate layer. After loading the three layers, each one is
represented by a different color.

Layers enable you to separate the component, solder, and drill information so that you can edit
one without affecting the others.

Layer List £
Your layer list icon looks like a stack of four sheets of paper or four planes on the upper toolbar.
You can use the layer list icon to control data on a layer by layer basis. You can change the
layers name, type, aperture table, color, and status. The status allow you to control the viewing
and editing of layers. There are three possible status modes. They are:.

1. View - Allows you to see the layer, but you cannot edit the data. It is
helpful for using a layer as a logical reference.

2. Edit- Allows you to modify, select, delete, mirror, and edit the data on
the layer. :

3. Hide- Allows you to hide the layer which prevents confusion while

working on other layers.

You can also set the layer’s type from this dialog. Go ahead and set the type for ‘274X.GBR’ to
‘Component’ and set the type for ‘274X.SOL’ to ‘Solder’. You will notice that the drill file is
already identified as ‘Drill’. '
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2.5 LAYER REGISTRATION

Purpose: To align the layers so that they line up (register) with one another.

The tutorial files provide you with a component side layer and a solder side layer that do not
register over the top of each other. To correct this data so that you can logically view the two
layers as they display on your computer monitor we must first mirror the “Solder’ layer.

Important: Inspect your CAD files to determine if the solder side is mirrored. If your solder
side is mirrored, the holes on each layer will NOT line up.

In the following procedure, you will first hide your drill layer since you will not be working with
it for now. Next, you will set the status for the component layer to Fiew. Then you will verify
that the status of the solder side layer is set to Edit.

Use the following steps to register each layer:

Step I: We will be moving the solder data to register with the component data so set the
component layer (274X.GBR) to View so we do not change it.

Step 2:  Set the 274X.NCD layer to Hide. It is already registered, so there is no need to view it.

Step 3:  Set the 274X.SOL layer to Edit and close the layer list. The only data that can now be
edited is the solder layer.

Step4: Zoom out and click on the select icon| &= ]. Then, use the mouse to drag a box around
the entire solder file (You can also use the Select All command in the Edit menu). The selected
data turns gray. The component side does not turn gray because it is still in ¥iew mode and
cannot be selected.

Step 5: The next step is to mirror the board. Click on the Mirror icon &K ;

Bxi

Step 6: Click on the Deselect | & | icon and use the mouse to drag a box around the entire file
or use De-Select All from the Edit menu.

Step 7: Next, use the Layer Registration icon to select the register tool. The first step is
to visually identify a pad on the solder layer and the component layer that should be registered
with each other. Move the cursor over the pad on the solder layer and click the left mouse
button. While holding the button down drag the cursor over the component pad. You will notice
that the line snaps to the center of the pads. Once the line snaps to the correct pad on the
component layer, release the mouse button. The data is then offset to the new position. If you
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K

make a mistake, you can use the Undo
to redo the previous undo action.

function to undo the previous action and Redo

Step 8: Once you have the layers registered, you can use the Layer Table to set the status of
each layer to Edit.

Note: In this tutorial the drill layer was already registered with the component side. However, if
the drill file was not registered you would follow all the same steps for the drill layer that you did
for the solder layer.

Save the File

At this point you should save your work. Under the File menu, select the Save As command.
Name the file “TUTORIAL STEP1.ISO”. This will allow you to come back to this step in the
tutorial easily if you wish to practice

IsoPro files are saved as *.iso files. A *.iso file includes all work done in IsoPro, including all
layers, aperture lists and drill racks. Work saved in a *.iso file may be restored at any time by
selecting the Open command under the File menu.

2.6 VERIFY THE APERTURE LIST

Purpose: To verify the aperture shapes and sizes used to draw
your circuit board’s pads and traces.

You should verify that your Aperture List is correct for you circuit board. The aperture list can

be viewed by clicking the aperture list icon -4 . For this tutorial your files use the RS274-X
standard, so all of the apertures were imported directly without intervention from the user.
T-Tech strongly recommends using RS274-X. Most CAD packages released within the last three
years support this format. If your files are not RS274-X, and you do not have an aperture list
loaded, you will notice that your dimensions default to 9.99 and 49.99. This is a very distinctive
size and will probably never be used on a circuit board. If you see this value, please
double-check it and manually edit the values to match those output from your CAD package.
Most CAD packages, when not using RS274-X, output the aperture list as a separate report file.
Converters are available for some CAD packages but it is also easy to enter the list manually.
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2.7 EDIT THE DRILL RACK
Purpose: To verify the drill sizes used for your circuit board’s drill holes.

The drill rack usually does not import into [soPro automatically, so you must edit it. Click on

the Drill Rack icon B2 ). Your drill sizes default to 24.99. Again, the *.99" is a flag that
indicates these are the default values. For this tutorial, simply set both tool sizes to 25.00 mils,
but you should always match the sizes of the holes in your board to those that your CAD
package outputs. These sizes can be determined by either looking at a report file output by your
CAD package or sometimes they are in the header of the drill file itself. If the latter is the case
then you can view it by opening the file in Notepad or a similar editor.

To verify the size of a particular drill hole you can check the properties of the drill hole. To
check the properties, place the cursor over the drill hole and click the right mouse button then
select properties. This dialog will show you the diameter and shape of drills, pads, and traces
and their center or starting/ending points.

In some cases there will be two entities buried on top of each other. In this case IsoPro will
iterate through both entities. Changing the properties of an entity in this manner will not be
necessary if the files from your CAD package are correct. If you want to do some final editing
without going back to the CAD package you can change the size or shape of an individual pad or
trace.

2.8 ISOLATE THE LAYERS

Purpose: To create an outline around the pads and traces of your design so that a circuit
board prototyping system can produce your board.

Step 1: Now that you have verified that your aperture list and files are correct, you need to
isolate the component and solder layers. —

Step 2:  Set the status of the drill and solder layers to Hide (this is not a required step, although
it can help prevent mistakes and makes your first few board designs run a little smoother).

Step 3: Click on Tools and then Isolate. You will now perform two isolations. Enter the two
diameters above under “Pass 1" and “Pass 2". Enter a zero diameter for “Pass 3"; this indicates
that this pass is not used. Then select the component and solder layer by holding down the CTRL
key while selecting both layers. The tool size can be entered in inches or mm. Metric mode can
be selected from the Preferences selection under the Edit menu.

Step 4: Click on the Isolate button.

Now would be a good time to save your files again, save it as TUTORIAL STEP2.ISO.
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IsoPro also provides a Remove Redundant option during mulit-pass Isolations. This feature
locates and deletes those sections of the smaller tool isolations which are completely overlapped
by larger isolations. On some types of circuit boards, the use of Remove Redundant can offer
significant savings in machine time and tool usage. The remove redundant option is enabled and
disabled via a small check box in the Isolation dialog. Please note, the speed of the Remove
Redundant feature is proportional to the square of the size of board (It is fast on medium size
boards, but can be very slow on larger boards).

Inspect the Isolations

It is a good idea to zoom in and inspect the isolation to make sure it was done properly. You

should see a clean outline around each electrical net. Use the zoom-in | & ] cursor to drag a

window around an area of interest then use the pan-hand 2 to move around and inspect the
data.

Clearances and Solderability

The first pass for this design was 10 mils (.010™), but the diameter you choose for your design
should be less than any pad-to-pad, pad-to-trace, or trace-to-trace clearance. This is so that the
tool can isolate all of the nets. Choosing a diameter that is too large will result in the merging of
nets on your board. For easier solderability, a larger second pass, in this case 31 mils (.0317), is
recommended. This is typically all that is required for a digital board. RF/Microwave and
analog customers might want to rub out or remove all unwanted copper for a section of the board
or for the entire board.

Rub Out the Base Copper

Ordinarily, you would not perform a rub out on a digital board; however, if you have a set of
fingers (edge connector) or something else (SMT component) that requires a rub out, you can rub
out any area of your board or the entire board. To do this, use the following steps:

Step 1:  Rubout only works on one side at a time. If you want to perform rubout on both the
component and solder sides you must repeat this procedure for each side. For the component
side case, set the isolation layers for the component side to edit and set the isolation layers for the
solder side to hide. (Conversely for the solder side case, set the isolation layers for the
component side to hide and set the isolation layers for the solder side to edit.) Zoom-In to the
area that you want to rubout. Rubout will automatically select the largest isolation layer in edit
mode. :

Step2:  Click on the Rubout @ icon. Now drag a window that describes the area in which
you wish to remove all of the excess copper. Repeat this step as necessary.
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To prevent unwanted copper slivers during machining, the rubout tool paths overlap by 2 default
percentage of 20%. This percentage may be increased or decrease by clicking on the
Preferences selection under the Edit menu and then editing the “Percent Overlap for Rubout”
field located on the Advanced Settings page.

2.9 EXPORT YOUR FILES

You are now done with your design except for writing the files that will be used by the
prototyping machine to disk.

Step 1:  Go to the layer list and set every layer that you want to export to Edit or View. After
doing this, inspect the drill file, the component isolation, and the component rub out. You want
to export the isolation layers, the rubout layers, and the drill layer(s). You do not need to export
the Gerber files, because they are your original CAD files.

Step 2: Click on File and then Export. You will notice that each time you performed an
isolation or a rubout, JsoPro created a new layer with the original layer name. The difference
being that the new layers have their type set to “Isolation” or “Rubout” and the tool diameter has
been appended to the end of the layer name. You want to export a QuickCAM file for each of
the following layers:

274X.GBR (.010™) Isolation
274X.GBR (.031") Isolation
274X.GBR (.031") Rubout
274X.SOL (.010™)  Isolation
274X.SOL (.031™) Isolation
274X.SOL (.031") Rubout
274X.NCD Drill

Note: Since QuickCAM (the machine driver for Quick Circuit) is not written for Windows 95 or
Windows NT you should make sure that the file names you choose are no longer than eight
characters. The “ PLT™ is appended automatically.

22 Copyright 1997 by T-Tech, Inc.
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For files to be used by Quick Circuit they must be loaded into the QuickCAM software. All of
T-Tech's modified HPGL format and may contain mill, drill, or route data. QuickCAM can only
load one file at a time. Before beginning to mill or drill your circuit board, it is recommended
that each file be viewed in QuickCAM. This allows you to inspect all of your files before you
begin to produce your circuit board.

Save Your Work

This completes the procedure to prototype your circuit board. Remember to always save your
work before exiting IsoPro. This enables you to return to IsoPro for editing.
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